# Table of Contents

## Standard Practices & Procedures

A. Introduction .................................................................................................................... 1

B. Energy Savings .................................................................................................................. 1

C. Logging On ....................................................................................................................... 1
   Accessing the University Administration Network .......................................................... 1
   Password Guidelines ........................................................................................................ 2
   Virtual Private Network (VPN) ........................................................................................ 4
   Wireless ............................................................................................................................ 9

D. Outlook ............................................................................................................................ 11
   E-Mail Suggestions ........................................................................................................... 11
   Opening Unknown E-Mail & Attachments ..................................................................... 12
   Out of Office Assistant ..................................................................................................... 12
   Inbox Folders .................................................................................................................. 12
   Public Folders .................................................................................................................. 13
   Reserving a Resource ...................................................................................................... 13
   Scheduling a Meeting ..................................................................................................... 13
   Setting Free/Busy Options ............................................................................................... 14
   Sharing Calendars .......................................................................................................... 14
   Sharing Contacts ............................................................................................................. 15
   Sharing Folders .............................................................................................................. 15
   Adding Additional Mailbox to Outlook Profile ............................................................. 15
   Webmail ......................................................................................................................... 15

E. Internet ............................................................................................................................ 16
   How to Search for Information on the Web ................................................................... 16
   Standard Browser ........................................................................................................... 16
   Pop-Ups ........................................................................................................................... 16

F. Files ................................................................................................................................ 16
   Salvaging Documents ..................................................................................................... 16
   Where to Save Files ........................................................................................................ 18
   Encryption ....................................................................................................................... 18
   Mapping Drive ............................................................................................................... 19
   Creating Shortcuts ......................................................................................................... 19
   Creating PDFs ................................................................................................................ 19

G. CD Storage ...................................................................................................................... 20
   How to Burn CDs ............................................................................................................ 20
   Supported Software ........................................................................................................ 20
H. Digital Photos ..................................................................................................................20
Digital Camera Settings ......................................................................................................20
Resizing Photos ..................................................................................................................20
Storing Photos ..................................................................................................................21

I. PC Maintenance ..............................................................................................................22
Deleting Temporary and Internet Files ...........................................................................22
Rebooting Machine ..........................................................................................................22
Removal of Software .........................................................................................................22
Virus Scan ..........................................................................................................................23

J. Printing ............................................................................................................................24
Adding Printers ..................................................................................................................24
Setting Default Printer ......................................................................................................24

K. Purchasing Hardware and Software ............................................................................25

L. Smartphones ................................................................................................................25
M. Bluetooth ......................................................................................................................26

Appendices
APPENDIX A – Tips for Google Searches on the Internet ..................................................27
APPENDIX B – Other Help Resources ............................................................................28
I. Standard Practices & Procedures

A. Introduction

This document has been written as a guideline for standard information technology practices and procedures for users working under University Administration. The information provided here will be based on Office 2010, unless otherwise noted.

If this document does not provide the answer you need, press F1 at any time and this will take you to Microsoft’s online help.

B. Energy Savings

It is recommended that computers are left on, but logged off each night and over breaks so they receive appropriate updates.

While it is not necessary to shut down the computer, periodically restarting it will close any open processes enabling a fresh reload. This helps with system stability. There will be times when it is necessary to restart, and for those circumstances the IT staff will send an advance e-mail.

Please turn off all other devices including monitors, printers and other peripherals (i.e., devices attached to your machine) each evening and during breaks.

C. Logging On

1. Logon to access the network from an University Administration location:

   • When an account is first setup, University Administration will forward the username and temporary password to the unit secretary or manager via the Protected Email Attachment Repository (PEAR – https://eas.admin.illinois.edu/eas/servlet/EasLogin?redirect=https://appserv3.admin.illinois.edu:443/pear/jsp/hello.jsp). To log in:

     1. Press CTRL-ALT-DEL to get to the login screen.
     2. In the User Name field, type the username.
     3. In the Password field, type the password.
     4. The Log On field should say UI. (If it does not, click on the dropdown menu and choose it.) If the Log On field is not visible, click on the Options >> button.
     5. Click OK.

     Note: If this is the first time logging into the system, a prompt to change the password will appear.
1. Press CTRL-ALT-DEL to get to the login screen.
2. If the correct user is not displayed, choose **Switch User**.
3. In the **User Name** field, type the username.
4. In the **Password** field, type the password.
5. Click on **right arrow** or select **Enter**.

Note: If this is the first time logging into the system, a prompt to change the password will appear.

---

1. Press CTRL-ALT-DEL to get to the login screen.
2. Click **OK**, if necessary.
3. If the correct user is not displayed, choose **Switch User**.
4. In the **User Name** field, type the username.
5. In the **Password** field, type the password.
6. Click on **right arrow** or press **Enter**.

Note: If this is the first time logging into the system, a prompt to change the password may appear.

---

2. **Password guidelines:**

The following are requirements for valid passwords under the strong password policy

- A password must contain at least one character from **three** of the following four character classes:
  - Uppercase letters (ABCDEFGHIJKLMNOPQRSTUVWXYZ)
  - Lowercase letters (abcdefghijklmnopqrstuvwxyz)
  - Numbers (0123456789)
  - Special characters (e.g. !@#$%^&*?)
- The password cannot contain any four (4) consecutive characters of your username.
- The password cannot contain any dictionary word greater than or equal to four (4) characters.
- The password must be at least eight (8) characters long.
- The password cannot be changed to any of your three (3) previous passwords.
- The minimum life of a password is 1 day.
- The password will expire annually.
Guidelines for Choosing Password

- Do not include information about yourself, your family, your friends, your work, your login, etc. Names, birthdays, pets, phone numbers, license plates, addresses are all easy to locate or guess.
- Choose a password that is not a word, place or name which can be found in a foreign or domestic dictionary (even if spelled backwards).
- Choose a password that can be typed quickly, without having to look at the keyboard. This makes it harder for someone to steal passwords by watching over your shoulder. Passwords like “12345”, “qwerty”, “Aa1b2c3”, or “bBBBBBB” are easily identified and should be avoided.

Ways to Create a Strong Password

- Join small words (three characters or less) with a numeral or special character ({}[]<>;:@#$%^&*()_-=+) and use uppercase and lowercase letters. (For example: I2caN/s3E,1t!) Note: The strength of a password is typically increased by including special characters.

- Combine first letters from a phrase or quote that’s important to you, but be sure to include uppercase letters, lowercase letters, and numerals. Lines from poems or songs work well. (For example, take the phrase “I can’t keep track of all these dang passwords!” and turn it into Ickt0atDp!.) You can use numerals for letters that resemble them, such as the number 0 for the letter o, or the number 5 for the letter s, although try not to do so within a full word, i.e. cam3ra.

- Extract vowels or consonants from words in a phrase, and mix in some non-alphabetic characters if necessary. (For example, take the phrase “Bond, James Bond” and turn it into Bnd,jAm5b. Or take the phrase “New and Improved” and turn it into N3w&Mprvd.)

Changing Your Password

- Users can initiate a password change on their own while signed into the network by doing the following:

1. Press CTRL-ALT-DEL.
2. Click on the Change Password button.
3. In the Old Password field, type the old password.
4. In the New Password field, type the new password.
5. In the Confirm New Password field, type the new password again.
6. Click OK.
1. Press CTRL-ALT-DEL.
2. Click on the Change a Password.
3. In the Old password field, type the old password.
4. In the New password field, type the new password.
5. In the Confirm password field, type the new password again.
6. Click right arrow button or select Enter.

1. Navigate your web browser to https://passwords.cites.uiuc.edu/
2. Click either “Log in with your NetID and password” (or “Log in with your security questions” if you don’t remember your credentials).
3. Once you successfully log in, choose which passwords you wish to change (must change AD password to log into computer)
4. In the New password field, type the new password.
5. In the Verify field, type the new password.
6. Click Set Passwords.

- Five (5) bad attempts lock the user out. This will be reset automatically after five (5) minutes.

When your password expires after one year you will be prompted to change your password when you log in. Messages to change your password will start to appear 14 prior to the actual expiration date.

3. Login to access network through a VPN: (Note: If viewing e-mail only, Webmail can be used. See Section D.13.)

- Setup the VPN connection. (Note: This may already have been setup by the IT staff.)

1. Click Start, Control Panel, and select Classic View.
2. Double-click Network Connections.
3. Click Create New Connection.
4. Click Next, then choose Connect to the network at my workplace, and click Next.
5. Choose Virtual Private network connection, and click Next.
6. Type name, i.e. AITS or UI VPN, and click Next.
7. Choose Do Not Dial the Initial Connection, and click Next.
8. Type aitsras1.aits.uiuillinois.edu (for Urbana) or aitsras2.aits.uiuillinois.edu (for Chicago), and click Next.
9. Click For All Users.
10. Check the box to add a shortcut to your desktop (optional), and click Finish.
11. A Connection Dialog box should open. (If not, double-click the shortcut on your desktop to open.) Click Properties.
12. Click the Options tab, and select the Include Windows logon domain checkbox, then click OK.
To set up VPN the first time (You MUST be connected to an Internet connection first):

1. Click Start button, then Control Panel
2. Click Network and Sharing Center
3. At this screen, choose ‘Set up a new connection or network’
4. Then choose ‘Connect to a workplace’ and click Next

![Set Up a Connection or Network](image)

If you get a screen asking ‘Do you want to use a connection that you already have?’, click ‘No, create a new connection’ and click Next

5. At this screen, click ‘Use my Internet connection (VPN)’

![Connect to a Workplace](image)
6. At this screen, you will input the address of the VPN and name it. Under ‘Internet address’, type aitsras1.ait.uillinois.edu (just like in the picture).

Under destination name, type something that will describe to you that this is the VPN to connect to for access to files. The name is not something the system uses; it is just for the user.

- To use the VPN connection:

1. Connect to the Internet in the usual fashion.
2. Either double-click on the shortcut on the desktop or click Start, Network and Dial-up Connection (or Connect To) and open AITS or UI VPN.
3. Enter username and password and enter UI on the Domain line.
4. Click Connect.
5. To disconnect from the VPN, right-click the connection’s icon in the lower right corner and click Disconnect (System Tray).

Executive Offices: exechelpdesk@uillinois.edu • AITS/UA: helpdesk2@uillinois.edu
Executive Offices-Urbana: 217/333-7393 • Executive Offices-Chicago: 312/996-1010
AITS/UA-Urbana: 217/333-3102 • AITS/UA-Chicago: 312/996-4806
1. At this screen, you will input your login information. Next to User name, type your netid (this is the username with which you log into your computer). Next to Password, input your password.

Click the checkbox next to ‘Remember this password’

Next to ‘Domain (optional)’, type UOFI

Click Connect

If everything is correct, you should see a screen that says ‘You are connected’.

The computer will save the connection. To reconnect, click on the Network button in the bottom-right of the computer screen. Then, choose the connection and Click the Connect button.
4. **Using wireless:**

For non-Planning and Administration supported buildings, contact the appropriate IT staff for using the respective wireless connection.

To request help with configuring a laptop to access the units listed below, please contact the local IT staff.

- **UAWireless**: Supports 802.11a (also called Dual Band). This is available in University Administration buildings.

<table>
<thead>
<tr>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Find and click on the <strong>wireless computer icon</strong> on the lower right-hand portion of the taskbar on the desktop.</td>
</tr>
<tr>
<td>2. Click on <strong>View Wireless Networks</strong>.</td>
</tr>
<tr>
<td>3. Locate the <strong>uawireless</strong> network and highlight, and click <strong>Connect</strong> (or double-click on network name).</td>
</tr>
</tbody>
</table>

- **UAGuest**: Supports G band wireless. Allows visitors with computers not in the UI domain to have basic access to the Internet. UAGuest may also be used by faculty and staff using their bluestem authentication for use with a notebook not on the UI domain. This is available only on a limited basis.

- **Guest Logon Procedure (AITS Offices Only):**
  1. UI sponsor sends support ticket one to two days in advance.
University Administration User Information
Standard information technology practices and procedures
for the University Administration offices at the University of Illinois

- Requires: sponsor name, vendor name, date and time needed (i.e. Wednesday, October 5, 2007 from 8-5).
  2. AITS Security will send the sponsor the logon and password.

- Visitor Logon Procedure (President’s House Only):
  1. Contact a member of the EOIT Staff for logon and password.

- Once logon and passwords have been obtained, follow these procedures for access:

  1. Find and click on the **wireless computer icon** on the lower right-hand portion of the taskbar on the desktop.
  2. Click on **View Wireless Networks**.
  3. Locate the **auguest** network and highlight, then click **Connect** (or double-click on the network name).
  4. Open **Internet Explorer** – a welcome screen will open.
  5. At the logon window, select **Faculty/Staff** or **Visitor** logon, whichever is applicable.
  6. For **Faculty/Staff login** use a Bluestem NetID and password. For **Visitor** login use the logon and password supplied by the sponsor.
  7. **A desktop window will open - this must stay open while connected.**
  8. To disconnect, close **Internet Explorer** and the connection window.

---

**VISTA How To**

1. Click on the **Windows button**.
2. Choose **Connect to**.
3. From the drop down menu, choose **Wireless**.
4. All available wireless networks will display.
5. Choose appropriate network, select **Connect**.
6. Open **Internet Explorer** – a welcome screen will open.
7. At the logon window, select **Faculty/Staff or Visitor** logon, whichever is applicable.
8. For **Faculty/Staff login**, use a Bluestem NetID and **password**. For **Visitor** login use the **logon and password supplied by the sponsor**.
9. A desktop window will open – this must stay open while connected.
10. To **disconnect**, close **Internet Explorer** and the connection window.

---

**Windows 7 How To**

1. Click the connection’s icon in the lower right corner.
2. Click **auguest**, then click **Connect**.
3. Open **Internet Explorer** – a welcome screen will open.
4. At the logon window, select **Faculty/Staff or Visitor** logon, whichever is applicable.
5. For **Faculty/Staff login** use a Bluestem NetID and password. For **Visitor** login use the logon and password supplied by the sponsor.
6. **A desktop window will open - this must stay open while connected.**
7. To disconnect, close **Internet Explorer** and the connection window.
D. **Outlook**

1. **E-Mail suggestions:**

   - E-mails and calendars get busier each year. The following suggestions were developed to help staff manage Outlook functions and communications more effectively.

     - If it will be a while before you can fully respond to a sender’s e-mail, send a quick reply letting the sender know about how long it will be before you provide a more complete response.

     - Whenever possible, respond to e-mails within 24 hours.

     - If a specific action is requested of the recipient, it would be helpful to put that action in the subject or bold it in the text. Outlook allows users to assign send options that provide the recipients more information regarding the e-mail’s importance. Send options include:

       - Assigning an e-mail a low (use down arrow in Outlook New Message toolbar), standard, or high priority (use exclamation point in Outlook New Message toolbar).

       - Request a reply from the recipient(s) if one is needed. *To make this setting change, open Outlook, click on Tools, Options, Preferences, Email, Email Options, Tracking Options, and select appropriate setting.*

     - When sending a message requesting some type of response or action, do not address it to several people. Instead address it to the person whom you expect to take action. If others need to receive the message, CC: them.

     - Do not respond “Thanks” on a routine basis when you ask someone a question and they respond. While this might seem to be the courteous thing to do, it creates another message that people have to open, read and delete. (A thank you is appropriate in certain circumstances though.)

     - If a message just provides information, put FYI somewhere in the subject line, letting the recipient know that the e-mail might be less important than other e-mails. (This is not to say that some FYI e-mails won’t have a high priority, use your best judgment.)
o As a personal time saver, try not handling e-mails more than once. This can be accomplished by placing them into organized folders.

o Try to keep messages as short as possible. Larger messages should be placed in memos and sent as attachments to e-mails.

o Send messages to specific people who require it, rather than a large group.

o Try to schedule a time to go through e-mail daily.

2. **Opening unknown e-mail and attachments:**

   - Do **NOT** open unexpected or unknown e-mails or attachments. When in doubt, contact EOIT (for EO) or AITS (for AITS/UA). Viruses and worms have been known to be delivered by this mechanism.

3. **Out of office assistant:**

   You can set a rule with Out of Office Assistant or an automatic reply to incoming messages can be set while out of the office. By setting a rule there are more conditions a message must meet. Select the one that is best for your needs. *(Note: These replies do not go outside the University.)*

   - To set an automatic reply to incoming messages:

     1. Open Outlook.
     2. On the **File** tab, click on **Info**, and select **Automatic Replies**.
     3. Click **Send automatic replies**.
     4. Inside the **Inside My Organization** and **Outside My Organization** tabs, customize your out of office messages.
     5. Click **OK**.

   - To create a rule with Out of Office Assistant:

     1. Open Outlook.
     2. On the **File** tab, click on **Info**, and select **Manage Rules and Alerts**.
     3. Click **New Rule**.
     4. Follow the wizard to create the desired rule.
     5. Click **Finish** when completed.

4. **Inbox folders:**

   - University Administration does not support personal folders. However,
subfolders can be created under the **Inbox** folder. (If .pst files have been created, drag and drop them to this new location.)

- To create new subfolders:

  1. Open Outlook.
  2. On the **Home** tab, right click on the folder where you want the subfolder, and select **New Folder**.
  3. Type the name of the new folder under **Name**.
  4. Make sure the folder is being created where you want and click **OK**.

5. **Public folders:**

- Public folders can be viewed by all University Administration staff. To add a folder to this area, contact EOIT (for EO) or AITS Security (for AITS/UA) by e-mail to Outlook Requests.

- To move an item to a public folder:

  1. Open Outlook.
  2. On the **Home** tab, right click on **Item**, select **Move**, and choose the appropriate folder.

6. **Reserving a resource:** Reserving a resource is made easy in Outlook. Examples of resources include: projectors, laptops, vehicles, and conference rooms. By reserving a resource electronically time is saved by not having to call or track down equipment.

   1. Open Outlook.
   2. In the **Home** tab, click on the **Calendar** shortcut.
   3. Select **New Appointment**, and select **Invite Attendees** (the TO button will pop up).
   4. Click on the **TO** button, and select the appropriate **Resource** (see explanation above).
   5. Click on **Resources**, and OK. Multiple resources can be set up here at one time.
   6. Fill out the rest of the appointment form, and click **Scheduling** on the ribbon.
   7. This screen will show when the **Resource** is free or busy.
   8. Once a date and time has been chosen, click **Send**.
   9. The owner of the Resource will either **Accept** or **Deny** the request.

7. **Scheduling a meeting:** Scheduling a meeting is made easy in Outlook. By scheduling a meeting electronically time is saved by not having to make multiple calls to check availability.
University Administration User Information
Standard information technology practices and procedures
for the University Administration offices at the University of Illinois

1. Open Outlook.
2. In the **Home** tab, click on the **Calendar** shortcut.
3. Select **New Meeting**.
4. Click on the **TO** button, select the participant(s), and click **required**.
5. Fill out the rest of the appointment form, and click **Scheduling Assistant** near the top of the window.
6. This screen will show when the participants are free or busy.
7. Once a date and time has been chosen, click **Send**.
8. The participants will either **Accept** or **Deny** the request.

8. **Setting free/busy options**: This is where the number of months of your calendar is published so that others can view free or busy options when they are scheduling meetings. **By default, Outlook displays 2 months.** You can expand that period of time by:

1. Open Outlook.
2. On the **File** tab select **Options** and **Calendar**.
3. Under **Calendar Options**, select **Free/Busy Options**.
4. Under the **Permissions** tab, select **Other Free/Busy**.
5. Change the number field to how many months you want to show.
6. Click **OK** three (3) times to exit out.

9. **Sharing calendars**:

- To be able to share a calendar in Outlook it must be setup to be shared. (By default it is **not**.)

1. In **Calendar** view in Outlook, click on the **Share Calendar** button. A blank e-mail opens.
2. Select who to share your calendar with and place in the **TO** field. **Send** like regular e-mail.

*Note: A checkmark can also be placed in the box requesting permission to view recipient’s calendar.*

Opening a Shared Calendar:

1. In **Calendar** view in Outlook, click on the **Open Calendar** button, then choose **Open Shared Calendar**.
2. Click on the **Name** button to choose whose calendar to view.
3. Click **OK**.
10. **Sharing contacts:**

- To be able to share contacts in Outlook they must be setup to be shared.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. In <strong>Contacts</strong> view in Outlook, click on the <strong>Share Contacts</strong> button. A blank e-mail opens.</td>
<td></td>
</tr>
<tr>
<td>2. Select who to share contacts with and place in the <strong>TO</strong> field. <strong>Send</strong> like regular e-mail.</td>
<td></td>
</tr>
<tr>
<td><em>Note: A checkmark can also be placed in the box requesting permission to view recipient’s contacts.</em></td>
<td></td>
</tr>
</tbody>
</table>

11. **Sharing folders:**

- To be able to share a folder in Outlook it must be setup to be shared. Personal folders can only be shared if they are under the **Inbox** folder in Outlook.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. In <strong>Mail</strong> view in Outlook, right click on the folder to share.</td>
<td></td>
</tr>
<tr>
<td>2. Click on <strong>Properties</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. A dialog box will open. Under the Permissions tab, Click on the <strong>Add</strong> button, select the user(s) to share folder with, and click <strong>OK</strong>.</td>
<td></td>
</tr>
<tr>
<td>4. With the user(s) name highlighted, choose the <strong>Permission</strong> level being given (click on dropdown menu for options). <em>Note: For an explanation on the permission levels, see Help in Outlook.</em></td>
<td></td>
</tr>
<tr>
<td>5. Do this for each user added.</td>
<td></td>
</tr>
<tr>
<td>6. Click <strong>OK</strong> when complete.</td>
<td></td>
</tr>
</tbody>
</table>

- To access a shared folder:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. In Outlook, click on the Folder List button (at the bottom-left, shaped like a folder). This will show all available folders.</td>
<td></td>
</tr>
</tbody>
</table>

12. **Adding mailbox to Outlook profile:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open <strong>Outlook.</strong></td>
<td></td>
</tr>
<tr>
<td>2. Under the File tab, choose <strong>Account Settings</strong>, then <strong>Account Settings</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. Click on <strong>Change</strong>, and <strong>More Settings</strong>.</td>
<td></td>
</tr>
<tr>
<td>4. On the <strong>Advanced</strong> tab, <strong>Add</strong> additional mailbox(es). Click on the <strong>Add</strong> button and put in the name of the Outlook mailbox to add.</td>
<td></td>
</tr>
<tr>
<td>5. Select <strong>OK</strong> until back at the main Outlook window.</td>
<td></td>
</tr>
</tbody>
</table>

13. **Using Webmail:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. In a web browser, type <a href="https://webmail.illinois.edu">https://webmail.illinois.edu</a></td>
<td></td>
</tr>
<tr>
<td>2. Type in <strong>NetID</strong> and <strong>password</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>Log On</strong>.</td>
<td></td>
</tr>
</tbody>
</table>
E. Internet
Do NOT install updates that have not been approved by IT staff.

1. Tips on how to search for information on the web:
   • Google Tips (see Appendix A).

2. Standard browser:
   • The standard browser for use is Internet Explorer.

3. Pops-ups:
   • Instead of choosing “X” to close pop-up windows, press Alt F4.

F. Saving Files

1. Salvaging documents (EO offices only):
   • Volume Shadow Copy & Previous Version Client. Snapshots of data that has changed are stored every hour starting at 7 a.m. and ending at 5 p.m. from Monday through Friday. If there are files that have not changed for some time, then there will be no previous version available for individual files. However, there will be previous versions of the entire folder. If a file has been created or had changes made recently, this will be useful.

To restore a deleted folder or file:

<table>
<thead>
<tr>
<th>How To</th>
<th>Windows XP How To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Right click on <strong>Start</strong>, choose <strong>Explore</strong>, highlight the network drive in the left panel, and right-click.</td>
<td></td>
</tr>
<tr>
<td>2. Open <strong>Properties</strong> and click on the <strong>Previous Versions</strong> tab.</td>
<td></td>
</tr>
<tr>
<td>3. Select one of the folders from the list provided.</td>
<td></td>
</tr>
<tr>
<td>4. Click on <strong>View</strong>.</td>
<td></td>
</tr>
<tr>
<td>5. Find the document or file that was deleted. Copy and paste it back into the drive that is open in <strong>Explorer</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>How To</th>
<th>Vista How To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Right click on the <strong>Windows</strong> button, double click on <strong>Computer</strong>.</td>
<td></td>
</tr>
<tr>
<td>2. Find the drive needed to restore from and drill down to folder/file needing to restore, right click on it.</td>
<td></td>
</tr>
<tr>
<td>3. Open <strong>Properties</strong> and click on the <strong>Previous Versions</strong> tab.</td>
<td></td>
</tr>
<tr>
<td>4. Find the document or file that was deleted. Copy and paste it back into the drive that is open in <strong>Explorer</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

*Note: Copy and Restore can also be done directly from the Previous Versions tab.*
1. Right click on **Start**, choose **Open Windows Explore**, right-click the network drive in the left panel, and choose **Restore Previous Versions**.
2. Select one of the folders from the list provided.
3. Click on **Open**.
4. Find the document or file that was deleted. Copy and paste it back into the drive that is open in **Explorer**.

**To restore an earlier version of document:**

1. Right click on **Start**, choose **Explore**, locate the network drive, and open the directory the document is located in.
2. Move cursor to the right pane of **Explore**, find the document, highlight it, and right-click.
3. Choose **Properties** and click on the **Previous Version** tab.
4. Earlier versions of this document will be shown. Choose either **View**, **Copy**, or **Restore** to overwrite the one that needs to be replaced.

*Note: If the network profile is setup to use folder redirection, restore previous versions from My Documents can be used.*

**VISTA How To**

1. Right click on the **Windows** button, double click on **Computer**.
2. Find the drive needed to restore from and drill down to folder/file needing to restore, right click on it.
3. Open **Properties** and click on the **Previous Versions** tab.
4. Find the document or file that was deleted. Copy and paste it back into the drive that is open in **Explorer**.

*Note: Copy and Restore can also be done directly from the Previous Versions tab.*

**Where to save files:**

- Departments should have a file structure setup on their network drive for shared directories.
- Each user also has a home directory where files can be stored that are not being shared.
- **For AITS/UA users:** To safeguard files, it is recommended to save them to the home or shared directories, as this information is backed up regularly and can be restored after a disk failure.
- There is the ability to setup Microsoft Office programs to save documents to particular areas by default. To do this:

1. Open the program (i.e. Word), click on File, choose Options, Save.
2. In Default File Location, click the Browse button to change location.
3. Click OK when complete.

3. **Encryption** (AITS/UA offices only): Staff using a laptop or home machine (either personal or University provided) that access and store University of Illinois data are required to deploy file encryption. This provides assurance that sensitive data remains protected in the event of loss of control of the device.

What is sensitive data? Sensitive data can be determined by any information that can link social security number in combination to any portion of a personal identifier (names, address, UIN, etc.), state issued ID or driver’s license number in combination with name and/or address, name and address information in combination with account number, as well as health information in combination with any personal identifier. Common sense items include passwords, salary information, general ledger information, etc.

**Recommendation**

Each employee utilize Microsoft’s built-in data encryption feature to encrypt any file location where data is stored (My Documents, Outlook OST files, CVS, etc.) and continue to encrypt any files that are created in the future.

1. **Right Click** on the folder or file to encrypt, select Properties. *Note:* It is recommended that the entire folder is encrypted.
2. Select the General tab, and click on Advanced.
3. Put a checkmark in the Encrypt contents to secure data. Leave checkmark in top 2 boxes.
4. Click OK.
5. Return to the General tab, and click OK.
6. A Confirm Attributes Changes box will popup. Make sure that Apply Changes to this folder, subfolders, and files is checked, and click OK.
7. If an Error Applying Attributes message is received, click on Ignore All.
8. Files may be unencrypted, in case of problems, by repeating this procedure and unchecking the Encrypt contacts to secure data box.
4. **Mapping a drive:**

1. Click on **Start**, **My Computer**, **Tools**, and **Map Network Drive**.
2. When the **Map Network Drive** dialog box appears, choose a drive (Z is fine).
3. In the **Folder** field, type `[file path name]` – get this from the specific IT unit.
4. Click **Finish**.
5. Use **Explorer** to browse to this drive to see documents.

5. **Creating shortcuts:**

1. Click on **Start**, and **All Programs**.
2. **Right click** on program that a shortcut is needed for.
3. Choose **Create Shortcut**.
4. Put on desktop.
5. Repeat as needed.

6. **Creating PDF documents:**

- From Office 2010

1. Click on the **File** tab, choose **Save As**, then choose **PDF** in the **Save as type** drop down box. *(Note: A PDF saved here cannot be converted to another file type by using Adobe Professional.)*

OR

2. Click on the **File** tab and select **Print**, when the print dialog box opens, choose **Adobe PDF** from the drop down menu, and click **OK**.
G. CD Storage

1. How to burn CDs:
   - Windows XP, Vista and 7 have built-in ability to write to a CD without additional software.

<table>
<thead>
<tr>
<th>Step</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Insert a blank CD into the computer.</td>
</tr>
<tr>
<td>2.</td>
<td>In the Explorer view, <strong>drag and drop (or copy and paste) the files</strong> to the</td>
</tr>
<tr>
<td></td>
<td>blank CD drive.</td>
</tr>
<tr>
<td>3.</td>
<td>Right click on the drive and select the option to <strong>write files to the CD</strong>.</td>
</tr>
<tr>
<td>4.</td>
<td>The CD will eject when complete.</td>
</tr>
</tbody>
</table>

2. Supported copying software:
   - The software that is supported is the software that came with the machine (i.e. Roxio).

H. Digital Photos

1. Digital camera settings:
   - With so many different digital cameras available it isn’t possible to state the right settings for all. The use of the photo will determine the camera setting. Users must refer to their camera’s handbook. (By default most cameras are set at the highest resolution.)

2. Resizing photos:
   - Inserting photos into documents can cause large document sizes that take several minutes to open if that photo was taken at a high resolution. Photos should be resized prior to insertion into documents in order to make the documents easier to load. *(Simply resizing them by grabbing the corners and shrinking the actual picture dimensions does **NOT accomplish the same thing.**) A photo can be resized by using Microsoft Picture Manager. Here is how resizing is done:
1. Open Microsoft Picture Manager, to do this:
2. Go to Start, Programs, Microsoft Office Tools, and Microsoft Picture Manager.
3. Open the desired picture file.
4. Click on Picture, and Resize.
5. There are three options to change the size: In the Width box, type 640, the Height box should automatically change OR pick a pre-defined width and height OR enter a percentage.
6. Click OK.
7. Click File, and Save (Save As another name if not wanting to replace the original photo).
8. Close program.

Note: Another option is to use the cropping tool.

- If high definition of the original photo is needed, then make smaller files for inserting into documents and saving them somewhere in a temporary folder to be used for that purpose so that the original is not lost. These smaller files can always be recreated if original files are kept. *(NOTE: Resizing a photo upward will not have as sharp a resolution as a photo originally taken at a lower resolution.)*

3. Storing photos:

- Be careful not to store duplicates of photos. This takes up a lot of room on the network. If photos are no longer being used – burn them to a CD and remove them from the network. *Personal photos should not be stored on the network.*
I. PC Maintenance

1. Deleting temporary and Internet files:
   - Periodically it’s a good practice to delete these files.

   **Temporary Files**
   1. Click on Start, Run, in the Open field, type `%tmp%`, and click OK.
   2. A Temp dialog box will open. The entire contents of this folder can be deleted. Select Edit, Select All (the documents will now be highlighted), press Delete the Selected Items, Yes. Sometimes a message will be received stating a file can not be deleted for one reason or another, which is okay, just highlight the files below that one and press Delete again.

   **Temporary Internet Files — (for Internet Explorer 8)**
   1. Open Internet Explorer.
   2. Select Tools, click Delete Browsing History.
   3. Choose what to delete or select Delete.

2. Rebooting machine:
   - Rebooting is always a great idea to allow the computer to reset. Many times this will correct a problem without any further troubleshooting.
   - Some examples of when to reboot include after a system crash, if the machine is running very slowly, or software is responding inconsistently.

3. Removal of University software:
   - DO NOT do this unless instructed to do so by IT staff.
4. **Virus scan:**

Virus scanning software is critical to protecting the environment from potential threats. The software automatically performs virus detection and removal tasks for specific viruses. If a computer system is infected, the tools will remove the virus and repair any damage.

The software adopted by the Planning and Administration units is McAfee Virus Scan Enterprise. It offers easily scalable protection, fast performance, and mobile design to protect the environment from viruses, worms, Trojan horses, as well as potentially unwanted code and programs. It can scan local and network drives, and Microsoft Outlook e-mail messages and attachments, then take the actions pre-configured to protect the environment.

The following is a description of the major components and the schedule for running them as determined by Planning and Administration.

**Auto-updates (VS8 Update)**

Automatic updates have been configured of detection definitions, scanning engine, and product upgrades from the McAfee download website.

- The schedule is set for hourly with a delayed missed task of 30 minutes.

**On-Demand Scan**

The on-demand scanner provides a method for scanning all parts of the computer for potential threats at regular intervals. It scans all local drives, memory and processes, and cleans or deletes them upon detection. The use of on-demand scans supplements the continuous protection that the on-access scanner offers.

- The schedule is set for weekly on Thursday at 11 p.m. with a delayed missed task of 30 minutes.

**On-Access Protection rules**

This feature continually detects potential threats that arrive on disks, from the network, or from various sources on the Internet. This option is always enabled.

**Recommendations**

1. Leave computer on Thursday evening (computer should always be left on, See Section B – Energy Savings) so the full On-Demand scan can take place. If this does not occur at the scheduled time, the next time the computer is started, a slow response time will be experienced as it attempts to run the full scan of the machine.
2. Users with personal home equipment are required to have virus scanning software that is current before attempting to connect to network resources. Antivirus software is available free from the campus web store. Logon to see the current version that is available. 
UIC ACCC:  [http://www.uic.edu/depts/accc/software/software.html](http://www.uic.edu/depts/accc/software/software.html)  
UIUC CITES:  [http://webstore.uiuc.edu/](http://webstore.uiuc.edu/)

J. Printing

1. **Adding printers**: Network printers are quickly setup on the workstation using the following procedure:

   1. Click on **Start**, choose **Run**.
   2. In the **Open** field, type in \ and the **name of the print server** named for your location (i.e. `\ADMINPRINT2` (UIC) or `\ADMINPRINT1` (UIUC) or `\EOPRINT` (EO) or `\URBPRINT1` select **Enter**.
   3. A window will appear showing all the resources available from the server. Right click and choose **Connect** on the appropriate printer OR double click on the appropriate printer.
   4. It will now be in the printer choices.

2. **Setting default printer**:

   1. Click on **Start**, choose **Printers and Faxes** (or from **Control Panel**, choose **Printers and Faxes**).
   2. **Right click** on the printer to be the default, select **Set as Default** from the drop down list.
   3. Click on the **Windows button**, select **Control Panel**, change to **Classic View**.
   4. Find **Printers**.
   5. **Right click** on the printer to be the default, select **Set as Default** from the drop down list.
K. Purchasing Hardware and Software

Please consult with someone from the appropriate UA IT office before proceeding to purchase computers, related office equipment, or software for use in the office. This will help ensure that items have been chosen which are most compatible with the environment, thereby increasing productivity. This also allows standardization of equipment, which helps us improve the quality of support provided. Please don’t hesitate to contact the IT staff for assistance in choosing software, computers, printers, scanners, networked copiers, PDA/Smartphones, or other equipment or peripherals connecting to computers or the network.

L. Smartphones

1. **Apple iPhone**

   1. Click on Settings and choose Mail, Contacts, Calendars
   2. Click Add Account… and choose Microsoft Exchange
   3. Under Email, type `<yournetid>@illinois.edu`
   4. Under Domain, type `uofi`
   5. Under Username and Password, type `<yournetid>` and password
   6. Under Description, put an account name and click Next
   7. Under Server, type `exchws.illinois.edu` and click Next

2. **Windows Mobile 5 or later:** *(Palm software is not supported.)*

   1. Turn on the mobile device, click Start, Programs, and Active Sync.
   2. Choose Menu, and Configure Server Settings.
   3. In the server name, type `webmail.illinois.edu`.
   4. Choose SSL.
   5. Click Next, type in `username` and password *(the same username and password that is used on the work machine).*
   6. Click the box to save this information.
   7. Choose Sync.
   8. If it fails, retype password.

3. **For Blackberry devices** *(EOIT Offices Only):*

   1. **Contact EOIT** for Blackberry license purchase and password to activate account.
   
   *Note: Enterprise Server Data Package must be purchased for this phone.*
M. **Bluetooth**

Bluetooth wireless technology is a short-range communications system intended to replace the cables connecting portable and/or fixed electronic devices.

1. Go to **My Bluetooth Places**.
2. Select **View Devices in Range**.
3. After the discovery process is complete, choose the appropriate icon.
4. **Right click** on the icon, and select **Discover Available Services**.
APPENDIX A

Tips for Google Searches on the Internet

1. Find similar terms.
   - Insert the tilde (~) in front of a search item, Google will retrieve sources matching the word as well as synonyms. Do not leave a space between the tilde and the search item. (Example: “~zoo” will yield the Animal Planet, Zoos, National Wildlife Federation)

2. Exclude terms.
   - By using the hyphen you will eliminate many irrelevant sites. (Example: “plasma-TV” or “plasma-TV-television”) You do not need to use the word “and.”

3. Substitute for unknown words.
   - Use asterisks to stand in for missing words. (Example: “Four * and * Years Ago”)

4. Find lost pages.
   - The cache option in Google will retrieve the last saved version of the page. This tool is helpful when you come across old pages from web sites that no longer exist or are no longer maintained. The cache link is found at the bottom line of the search result.

5. Get the name.
   - If you have the phone number but want the name and/or location, type in the number. Do not include hyphens, parentheses or spaces. (What you are looking for may not be on the top of the list provided by Google.)

6. Look up synonyms.
   - Type “define: and your search word.” (Example: “define: legislation”)

7. Explore specific sites.
   - Restrict your search solely to a specific site by using the site keyword. (Example: “the pc guy site:northjersey.com”)

8. Get the picture.
   - Go to the Google home page and click on images. You can narrow your searches using the advanced function and retrieve certain types or sizes of files.
APPENDIX B Other
Help Resources

University of Illinois at Chicago (ACCC):
consult@uic.edu
312/413-0003

University of Illinois at Springfield (ITS):
technicalsupport@uis.edu
217/206-7357
877/847-0443

University of Illinois at Urbana-Champaign (CITES):
consult@uiuc.edu
217/244-7000

Decision Support
2001 S. First Street: MC 657
Champaign, IL 61820
Phone: 217/244-6419
Fax: 217/265-6501